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Prefazione

Questo breve manuale include una rapida introduzione all'installazione di SUSE Linux
Enterprise Server. Offre una panoramica dei vari tipi di applicazioni e installazioni per
ogni piattaforma supportata da SUSE Linux Enterprise Server e una breve descrizione
del processo di installazione.

E anche disponibile un servizio qualita. Gli esperti possono rispondere alle domande
sull'installazione o la configurazione, mettere a disposizione aggiornamenti affidabili
sulla sicurezza e assistere a progetti di sviluppo.

1 Feedback

E possibile inviare i propri commenti e suggerimenti relativi a questo manuale e agli
altri documenti forniti con questo prodotto. Per inserire i commenti, utilizzare I'apposita
funzionalita disponibile in fondo a ogni pagina della documentazione in linea e immettere
eventuali commenti.

2 Documentazione aggiuntiva

Per documentazione aggiuntiva su questo prodotto, consultare ht tp: //www.novell
.com/documentation/slesl0/index.html:

Architecture-Specific Information
Informazioni sull'architettura necessarie per la preparazione di una destinazione
per l'installazione di SUSE Linux Enterprise Server.

Installation and Administration
Approfondimenti su installazione e amministrazione di SUSE Linux Enterprise
Server.

Per una panoramica della documentazione sul prodotto SUSE® Linux Enterprise
Desktop consultare http://www.novell.com/documentation/sled10/
index.html.


http://www.novell.com/documentation/sles10/index.html
http://www.novell.com/documentation/sles10/index.html
http://www.novell.com/documentation/sled10/index.html
http://www.novell.com/documentation/sled10/index.html

vi

3 Convenzioni della documentazione

Nel presente manuale vengono utilizzate le convenzioni tipografiche riportate di seguito.

/etc/passwd: nomi di file e directory

segnaposto: sostituire segnaposto con il valore reale
PERCORSO: PERCORSO della variabile d'ambiente

1s, ——help: comandi, opzioni e parametri

utente: utenti o gruppi

Alt, Alt + F1: un tasto o una combinazione di tasti da premere. I tasti vengono
rappresentati in maiuscolo come su una tastiera.

File,File > Salva con nome: voci di menu, pulsanti

» amd64 ipf: Questo paragrafo riguarda solo le architetture specificate. Le frecce
contrassegnano l'inizio e la fine del blocco di testo. <

> ipseries s390 zseries: Questo paragrafo riguarda solo le architetture specificate.
Le frecce contrassegnano 1'inizio e la fine del blocco di testo. <

Pinguini danzanti (Capitolo Pinguini, Taltro manuale): riferimento a un capitolo
di un altro manuale.
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Parte I. Installazione nella
famiglia di processori x86,
AMDG64, Intel 64 e Itanium






Considerazioni
sull'installazione

In questo capitolo vengono illustrate tutte le decisioni che & necessario prendere prima
di installare SUSE® Linux Enterprise Server in un computer con processore x86,
AMD64, Intel 64 e Itanium. Le informazioni sui requisiti hardware e software necessari
per l'installazione di SUSE Linux Enterprise Server in un computer con processore x86,
AMD64, Intel 64 e Itanium sono disponibili nel manuale Architecture-Specific
Information contenuto come documento PDF nella directory /docu del primo CD o
DVD.

1.1 Tipo di installazione

SUSE Linux Enterprise Server viene normalmente installato come sistema operativo
indipendente. Con l'introduzione di Xen & anche possibile eseguire piu istanze di SUSE
Linux Enterprise Server sullo stesso componente hardware. Tuttavia, la procedura di
controllo dell'installazione di Domain 0 per Xen € uguale a quella delle altre installazioni
tipiche con alcuni pacchetti aggiuntivi. Il processo di installazione dei guest Xen &
descritto nella Installation and Administration, disponibile sul sistema installato e sul
primo CD o DVD.

1.2 Metodi di avvio

In base al tipo di hardware installato, sono disponibili i seguenti metodi di avvio per la
prima procedura di avvio precedente all'installazione di SUSE Linux Enterprise Server:

Considerazioni sull'installazione
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Tabella 1.1 Opzioni di avvio

Opzione diavvio Uso

Unita CD o DVD Il metodo di avvio piu semplice. In questo caso, &€ necessario che
sul sistema sia disponibile localmente un'unita CD ROM o DVD.

Dischi floppy o Individuare le immagini necessarie per la creazione di dischi di

USB avvio sul primo CD o DVD nella directory /boot. Vedere
anche il file README disponibile nella stessa directory. E
possibile effettuare 1'avvio da una memory stick USB solo se il
BIOS del computer supporta questa operazione.

PXE o bootp Devono essere supportati dal BIOS o dal firmware del sistema
in uso. Questa opzione richiede che alla rete sia collegato un
server di avvio. Altrimenti, questa attivita puo essere gestita da
un altro sistema SUSE Linux Enterprise Server.

Disco rigido E anche possibile avviare SUSE Linux Enterprise Server dal
disco rigido. A questo scopo, copiare il kernel (1inux) e il
sistema di installazione (initrd) dalla directory /boot /
loader del primo CD o DVD nel disco rigido, quindi
aggiungere una voce appropriata nel caricatore di avvio.

1.3 Origine dell'installazione

Durante I'installazione di SUSE Linux Enterprise Server € necessario che i dati correnti
relativi all'installazione siano disponibili in rete, su una partizione del disco rigido o su
un CD ROM o DVD Ilocale. Per effettuare 1'installazione dalla rete, € necessario un
server di installazione. Per rendere disponibili i dati di installazione, configurare un
computer qualsiasi in un ambiente Unix o Linux come server NFS, HTTP o FTP. Per
rendere i dati di installazione disponibili da un computer Windows, divulgarli con SMB.

Per semplificare la selezione dell'origine dell'installazione, configurare un server SLP
nella rete locale. Per ulteriori informazioni, consultare Sezione 4.2, «Setting Up the
Server Holding the Installation Sources» (Capitolo 4, Remote Installation, Installation
and Administration).
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1.4 Destinazione di installazione

Quasi tutte le installazioni vengono effettuate su un disco rigido locale. E quindi
necessario che i controller del disco rigido siano disponibili nel sistema di installazione.
Se un particolare controller, ad esempio RAID, necessita di un modulo di kernel
aggiuntivo, inserire un disco di aggiornamento per tale modulo nel sistema
dell'installazione.

Come altre destinazioni di installazione € possibile utilizzare tutti i tipi di dispositivi a
blocchi che supportano uno spazio su disco e una velocita di esecuzione sufficienti per
il sistema operativo. E ad esempio possibile utilizzare dispositivi a blocchi di rete quali
1SCST o SAN. E anche possibile effettuare I'installazione sui file system di rete che
offrono le autorizzazioni Unix standard. Puo tuttavia non essere possibile avviare questi
file system se non supportati da initramf s prima dell'avvio del sistema vero e proprio.
Queste installazioni sono utili se & necessario avviare lo stesso sistema in diverse
posizioni oppure se si intende utilizzare le funzioni Xen, quali la migrazione di un
dominio.

1.5 Diversi metodi di installazione

In SUSE Linux Enterprise Server sono disponibili numerosi metodi differenti per il
controllo di un'installazione:

+ Installazione sulla console

+ Installazione tramite console seriale
+ Installazione con AutoYaST

+ Installazione via SSH

+ Installazione con VNC

Per impostazione predefinita, viene utilizzata la console. Se € necessario effettuare
l'installazione in numerosi computer simili, & consigliabile creare un file di
configurazione AutoYaST e renderlo disponibile al processo di installazione. Vedere
anche la documentazione relativa ad aut oyast 2 in Capitolo 5, Automated Installation
(tInstallation and Administration).
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Procedura di installazione

Questo capitolo include una panoramica dei passaggi necessari per completare
l'installazione di SUSE® Linux Enterprise Server nella modalita richiesta. Le
informazioni dettagliate sui requisiti necessari per l'installazione di SUSE Linux
Enterprise Server su un computer con processore x86, AMD64, Intel 64 e [tanium sono
disponibili nel manuale Architecture-Specific Information contenuto nella directory
/docu del primo CD o DVD in formato PDF stampabile. Reference include una
descrizione esauriente della modalita di installazione e configurazione del sistema con
YaST.

2.1 Avvio da un'unita intercambiabile
locale

Per I'installazione € anche possibile utilizzare le unita CD ROM e floppy e le memory
stick USB. Modificare il computer in base alle proprie esigenze:

1. Assicurarsi che I'unita sia specificata nel BIOS come avviabile.
2. Inserire il disco di avvio nell'unita e avviare il processo di avvio.

3. Il menu di avvio del disco CD, DVD, floppy o USB consente di trasferire diversi
parametri al sistema di installazione. Vedere anche Sezione 4.4.3, «Using Custom
Boot Options» (Capitolo 4, Remote Installation, tInstallation and Administration).
Se I'installazione deve essere effettuata tramite rete, specificare qui 1'origine
dell'installazione.

Procedura di installazione
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4. Se durante 1'installazione si verificano problemi imprevisti, effettuare I'avvio in
modalita protetta.

2.2 Installazione tramite rete

Per effettuare un'installazione tramite un'origine in rete, € necessario utilizzare un
apposito server. La procedura per l'installazione di questo server ¢ illustrata in
Sezione 4.2, «Setting Up the Server Holding the Installation Sources» (Capitolo 4,
Remote Installation, 1Installation and Administration).

Se si dispone di un server SLP, selezionare SLP come origine di installazione nella
prima schermata di avvio. Durante la procedura di avvio selezionare 1'origine di
installazione che si desidera utilizzare tra quelle disponibili.

Se i CD o DVD sono disponibili in rete, utilizzarli come origine di installazione. In
questo caso, specificare il parametro install=<URL> con i valori appropriati al
prompt di avvio. Per informazioni dettagliate su questo parametro, vedere Sezione 4.4.3,
«Using Custom Boot Options» (Capitolo 4, Remote Installation, 1Installation and
Administration).

2.3 Controllo di un'installazione in
remoto

Sono disponibili tre opzioni per controllare le installazioni da un computer remoto:

installazione tramite SSH, installazione tramite console seriale e installazione tramite
VNC. Queste possibilita sono illustrate nel manuale Architecture-Specific Information,
disponibile nella directory /docu del primo CD o DVD in formato PDF stampabile.
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Parte Il. Installazione su IBM
POWER






Considerazioni
sull'installazione

In questo capitolo vengono illustrate tutte le decisioni che & necessario prendere prima
di iniziare a installare SUSE® Linux Enterprise Server su IBM &ipseries. I requisiti
hardware e software correnti necessari per l'installazione di SUSE Linux Enterprise
Server sui dispositivi IBM POWER sono elencati in Capitolo 1, Requirements

(* Architecture-Specific Information) e disponibili come documento PDF stampabile
nella directory /docu del primo CD.

3.1 Tipi di installazione

SUSE Linux Enterprise Server offre due diversi tipi di installazione in IBM POWER:
un'installazione nell'intero sistema e un'installazione in una partizione logica (LPAR).

iSeries
In questo tipo di computer, Linux puo essere installato solo in una partizione logica.
Per effettuare 1'installazione in iSeries, € necessaria una connessione telnet che
consenta di controllare I'intero processo di installazione, dall'inizio alla fine. Un
server di installazione in rete rappresenta un'ottima origine di installazione.

pSeries
Linux puo essere installato nell'intero sistema. Con IBM pSeries p630, p655, p670
e p690 & anche possibile installare Linux in una partizione logica. E inoltre possibile
avviare questi due sistemi senza partizionamento ed effettuare l'installazione
sull'intero sistema (partizione completa del sistema). Come origine di installazione
¢ possibile utilizzare un'unita CD ROM o DVD, oppure un server di installazione
in rete.

Considerazioni sull'installazione 11
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eServer i5/p5, System i5/p5, OpenPower
E possibile installare Linux nell'intero sistema (modalitd non gestita) o in una
partizione logica. Come origine di installazione € possibile utilizzare un'unita CD
ROM o DVD, oppure un server di installazione in rete.

JS20 Blade, JS21 Blade
Questo tipo di computer supporta solo 1'installazione di Linux nell'intero sistema
blade. Come origine di installazione ¢ possibile utilizzare un'unita CD ROM o
DVD, oppure un server di installazione in rete.

IntelliStation, ATX Workstation e Server
E possibile installare Linux solo nell'intero sistema. Come origine di installazione
¢ possibile utilizzare un'unita CD ROM o DVD, oppure un server di installazione
in rete.

3.2 Opzioni IPL

In base all'hardware in uso e al tipo di installazione selezionata, per I'IPL iniziale sono
disponibili le seguenti opzioni di installazione di SUSE Linux Enterprise Server:

Tabella 3.1 Opzioni IPL

Opzione IPL Uso

Unitd CD o DVD  Procedura di avvio piti semplice. E necessario che sul sistema
sia disponibile un'unita CD ROM o DVD a livello locale.

Rete E anche possibile avviare SUSE Linux Enterprise Server dalla
rete. In questo caso, & necessario copiare il kernel appropriato
(suseboot/inst64 o ISERIES64) dal primo CD in un
server di avvio. Per effettuare 1'avvio dalla rete, e possibile
utilizzare il firmware o i5/0S.

3.3 Origine dell'installazione

I file per l'installazione di SUSE Linux Enterprise Server devono essere disponibili
sulla rete locale oppure su un'unita CD ROM o DVD disponibile a livello locale. Per
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creare un'origine in rete, impostare un sistema Linux o Unix come server HTTP, NFS
o FTP. E anche possibile condividere i file di installazione tramite SMB da un computer

Windows.

Per semplificare la selezione di un'origine di installazione, configurare un server SLP
nella rete locale. Questo passaggio viene descritto in Sezione 4.2.1, «Setting Up an
Installation Server Using YaST» (Capitolo 4, Remote Installation, tInstallation and

Administration).

3.4 Destinazioni di installazione

SUSE Linux Enterprise Server puo essere installato su diversi tipi di supporti di

archiviazione di massa di IBM Power.
iSeries

+ DASD (disco rigido)

+ Disco virtuale di IBM iSeries
pSeries

+ DASD (disco rigido)

+ SAN tramite canale in fibra ottica
eServer i5/p5, System i5/p5, OpenPower

+ DASD (disco rigido)

+ SCSI virtuale

+ SAN tramite canale in fibra ottica
JS20 Blade, JS21 Blade

+ Disco rigido locale
IntelliStation, ATX Workstation e Server

+ Disco rigido locale

Considerazioni sull'installazione
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3.5 Connessione al sistema di
installazione

SUSE Linux Enterprise Server fornisce quattro diversi metodi di connessione al sistema
di installazione: SSH, VNC, console seriale e console su schermo. Le versioni del
software SSH, VNC o terminal variano in base al sistema operativo eseguito sulla
workstation utilizzata per effettuare la connessione al sistema di installazione.

Se € necessario installare piu partizioni o computer identici, ¢ consigliabile creare un
file di configurazione AutoYaST. A questo punto & possibile iniziare il processo di
installazione. Consultare la documentazione di AutoYaST in Sezione 5.2, «Rule-Based
Autoinstallation» (Capitolo 5, Automated Installation, *Installation and Administration).
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Procedura di installazione

Questo capitolo offre una panoramica dei passaggi necessari per installare SUSE®
Linux Enterprise Server nella modalita selezionata. Per ulteriori informazioni sulla
preparazione di un'installazione SUSE Linux Enterprise Server su IBM POWER,
consultare il manuale Architecture-Specific Information, disponibile come documento
PDF stampabile nella directory /docu del primo CD. Una descrizione completa dei
processi di installazione e configurazione con YaST ¢ disponibile in Capitolo 3,
Installation with YaST (tInstallation and Administration) e Capitolo 8, System
Configuration with YaST (*Installation and Administration).

4.1 Installazione in un intero sistema

Per effettuare 1'installazione in un intero sistema, & necessario eseguire i passaggi
seguenti. In questo caso, i singoli blade inclusi in un centro blade possono anche essere
considerati come un sistema intero.

1 Verificare i requisiti hardware (vedere anche Sezione 1.1, «Hardware
Requirements» (Capitolo 1, Requirements, 1 Architecture-Specific Information)).

2 Verificare i requisiti software (vedere anche Sezione 1.2, «Software
Requirements» (Capitolo 1, Requirements, 1 Architecture-Specific Information)).

3 Configurare il sistema correttamente in modo da attivare I'avvio da CD ROM,
DVD o dalla rete.

Procedura di installazione
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+ Per informazioni su pSeries, vedere anche Sezione 2.2, «Preparing for
Installation on an IBM pSeries Models» (Capitolo 2, Preparation,
t Architecture-Specific Information). Lo stesso vale per la workstation ATX
e il server ATX (solo per l'installazione in un intero sistema).

+ Per eServer i5/p5, System i5/p5 e OpenPower, vedere anche Sezione 2.1,
«Preparing for Installation on IBM eServer i5/p5, System i5/p5, and
OpenPower Models» (Capitolo 2, Preparation, t Architecture-Specific
Information).

+ Periblade di JS20/JS21, vedere anche Sezione 2.3, «Preparing an Installation
on IBM JS20/JS21 Blades» (Capitolo 2, Preparation, 1t Architecture-Specific
Information).

4 Avviare l'installazione da un CD ROM, DVD o dalla rete. Vedere anche
Sezione 2.2.3, «Setting Up the Installation Source» (Capitolo 2, Preparation,
1 Architecture-Specific Information).

5 Installare il software ed eseguire la configurazione di rete di base. Vedere anche
Capitolo 3, Installation with YaST (*Installation and Administration).

4.2 Installazione in una LPAR

1 Verificare i requisiti hardware. Vedere anche Sezione 1.1, «Hardware
Requirementsy (Capitolo 1, Requirements, 1 Architecture-Specific Information).

2 Verificare i requisiti software. Vedere anche Sezione 1.2, «Software
Requirementsy» (Capitolo 1, Requirements, 1 Architecture-Specific Information).

3 Preparare un client VNC per il processo di installazione. Vedere anche
Sezione 4.1.1, «Simple Remote Installation via VNC—Static Network
Configurationy (Capitolo 4, Remote Installation, tInstallation and Administration).

4 Preparare il sistema nel relativo firmware o sull'i5/OS:

+ Per informazioni su iSeries, vedere anche Sezione 2.4, «Preparing an
Installation on IBM iSeries Models» (Capitolo 2, Preparation, * Architecture-
Specific Information).
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+ Per informazioni su pSeries p630, p655, p670 e p690, vedere anche
Sezione 2.2, «Preparing for Installation on an IBM pSeries Models»
(Capitolo 2, Preparation, 1t Architecture-Specific Information)

+ Per eServer i5/p5, System i5/p5 e OpenPower, vedere anche Sezione 2.1,
«Preparing for Installation on IBM eServer i5/p5, System i5/p5, and
OpenPower Models» (Capitolo 2, Preparation, * Architecture-Specific
Information)

5 Configurare un client per l'accesso al sistema durante l'installazione. Vedere
anche Sezione 2.4.3, «Client for the Operation of the Installation Software»
(Capitolo 2, Preparation, t Architecture-Specific Information).

6 Per iSeries, configurare 1'origine IPL in i5/OS e vedere anche Sezione 2.4.5,
«IPL: Starting the NWSD (WRKCFGSTS *NWS)» (Capitolo 2, Preparation,
t Architecture-Specific Information).

7 Installare il software ed eseguire la configurazione di rete di base. Vedere anche
Capitolo 3, Installation with YaST (*Installation and Administration).

Procedura di installazione 17






Parte lll. Installazione in IBM
System z






Considerazioni
sull'installazione

In questo capitolo vengono riepilogate tutte le decisioni che devono essere prese per la
pianificazione di un'installazione di SUSE® Linux Enterprise Server nei computer che
eseguono IBM &zseries. I requisiti aggiornati hardware e software per l'installazione
di SUSE Linux Enterprise Server in questi computer sono indicati nel manuale
Architecture-Specific Information disponibile in formato PDF stampabile nella directory
/docu del primo CD.

5.1 Tipi di installazione

SUSE Linux Enterprise Server consente due tipi di installazione diversi nei computer
IBM zseries;:

Installazione LPAR
L'installazione di SUSE Linux Enterprise Server per IBM &zseries in una partizione
logica separata (Separate Logical Partition, LPAR) consente a SUSE Linux
Enterprise Server di utilizzare una porzione specifica della memoria fisica. Inoltre,
¢ possibile specificare il numero dei processori da utilizzare. Questa modalita
consente 'esecuzione contemporanea di pit sistemi operativi su un unico computer.

Installazione in z/VM
In modalita z/VM, SUSE Linux Enterprise Server per IBM &zseries viene eseguito
come sistema host sul computer z/VM (macchina virtuale). 11 vantaggio di questo
tipo di installazione sta nel fatto che z/VM ha il controllo completo su SUSE Linux
Enterprise Server. Inoltre, puo rivelarsi molto utile per lo sviluppo del kernel o il
debugging basato sul kernel. Infine, € molto facile modificare la configurazione

Considerazioni sull'installazione
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dell'hardware di un sistema Linux su computer host. La creazione di sistemi SUSE
Linux Enterprise Server su computer host ¢ molto agevole, poiché ¢ possibile
eseguire contemporaneamente diverse centinaia di istanze Linux.

Installazione da CD-ROM fornito con il dispositivo FCP
Per eseguire un IPL in una LPAR o in modalita VM e possibile utilizzare un CD-
ROM in dotazione all'FCP. I dati dell'installazione verranno letti direttamente dal
CD-ROM.

5.2 Opzioni IPL

In base all'hardware utilizzato e al tipo di installazione scelto, sono disponibili le seguenti
opzioni per I'PL iniziale da impostare prima dell'installazione di SUSE Linux Enterprise
Server:

Tabella 5.1 Opzioni IPL

Opzioni IPL Ambito

Nastro allegato Puo essere utilizzato per qualsiasi tipo di installazione.
ESCON/FICON L'unico requisito ¢ la disponibilita di una libreria a nastro.
Lettore VM Puo essere utilizzato in modalita VM. I dati necessari

devono essere stati precedentemente trasferiti nel sistema
7z/VM (ad esempio tramite FTP).

CD-ROM o server Possono essere utilizzati per effettuare un IPL in un LPAR.
I dati di installazione possono essere letti direttamente da
CD-ROM o caricati nel sistema di installazione tramite
FTP.

5.3 Origine dell'installazione

In caso di CD-ROM allegato all'FCP, i dati di installazione vengono letti dal CD-ROM.
Per tutte le altre opzioni IPL, i dati di installazione devono essere disponibili sulla rete
interna. In un ambiente Unix o Linux, i dati di installazione possono essere forniti su
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una workstation configurata come server NFS o FTP. Per recuperare i dati di
installazione da una workstation Windows, € necessario ricorrere a una condivisione
SMB. Per Windows sono disponibili diversi pacchetti software per FTP, tuttavia, il
loro utilizzo non € sempre privo di problemi.

5.4 Inizializzazione di una connessione
al sistema di installazione

SUSE Linux Enterprise Server offre tre diversi metodi per l'inizializzazione di una
connessione al sistema di installazione. Scegliere SSH, X o VNC. In base al sistema
operativo in esecuzione sulla workstation che inizializza la connessione al sistema di
installazione, le versioni di queste applicazioni possono essere differenti.
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Procedura di installazione

In questo capitolo viene presentata una panoramica delle varie fasi necessarie per una
completa installazione di SUSE® Linux Enterprise Server nella modalita desiderata.
Le informazioni dettagliate sulla preparazione di un'installazione SUSE Linux Enterprise
Server in IBM &zseries sono indicate nel manuale Architecture-Specific Information,
disponibile in formato PDF stampabile nella directory /docu del primo CD. In
&adguide ¢ disponibile una descrizione dettagliata dell'installazione della configurazione
del sistema tramite YaST.

6.1 Installazione LPAR

1 Scegliere un'opzione adeguata per I'IPL iniziale prima dell'installazione. In caso
di installazione LPAR, scegliere tra CD-ROM or Server (CD-ROM o server) o
Tape (Nastro).

2 Tramite FTP o SMB, rendere disponibili sulla rete i supporti di installazione o i
relativi dati e assicurarsi che i percorsi corrispondenti siano accessibili da YaST.

3 Scegliere una delle seguenti opzioni:
+ Tramite HMC, preparare I'IPL da CD-ROM o dal server.

+ Tramite FTP trasferire al nastro il kernel IPL del nastro, il parmfile e il disco
RAM iniziale e rendere disponibile 1'unita a nastro tramite IOCDS.

4 Eseguire I'IPL per il sistema di installazione.

Procedura di installazione
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5 Configurare la rete.

6 Scegliere un tipo di connessione al sistema di installazione (SSH, X o VNC),
quindi stabilire la connessione.

7 Avviare l'installazione base con YaST.
8 Eseguire il primo IPL del sistema installato.

9 Eseguire nuovamente la connessione al sistema di installazione e avviare &yast
per continuare il processo di installazione e configurare SUSE Linux Enterprise
Server.

6.2 Installazione z/VM

1 Scegliere un'opzione adeguata per 1'IPL iniziale prima dell'installazione. Per
l'installazione in z/VM, scegliere VM Reader (Lettore VM) O Tape (Nastro).

2 Tramite FTP o SMB, rendere disponibili sulla rete i supporti di installazione
o irelativi dati e assicurarsi che i percorsi corrispondenti siano accessibili da
YaST.

3 Creare un ospite Linux in z/VM, con assegnazione della memoria resa
disponibile e definizione della connessione di rete desiderata.

4 Scegliere una delle seguenti opzioni:

+ Tramite FTP trasferire a un minidisco, accessibile all'ospite in z/VM, il
kernel del lettore VM, il parmfile e il disco RAM iniziale e creare un script
di avvio REXX per I'IPL del lettore VM.

+ Tramite FTP trasferire a un minidisco, accessibile all'ospite in z/VM, il

kernel IPL del nastro, il parmfile e il disco RAM iniziale e trasferire questi
file al nastro, utilizzando, ad esempio, uno script REXX.

5 Eseguire I'IPL del sistema di installazione.

6 Configurare la rete.
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Scegliere il tipo di connessione al sistema di installazione (SSH o VNC),
quindi stabilire la connessione.

Avviare l'installazione base con YaST.
Eseguire il primo IPL del sistema installato.
Eseguire nuovamente la connessione al sistema di installazione e avviare YaST

per continuare il processo di installazione e configurare SUSE Linux Enterprise
Server.

Procedura di installazione
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